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Requisitos del Sistema

e Reform 12 Enterprise o Reform 12 PDC
e Plugin MOST

e Plugin Alchemy

e Plugin MOST Alchemy

» Para evaluacion y demostracion: Windows XP, Windows 2003 Server, Windows
Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de
64 bits)

e Para los sistemas de produccidon: Windows Server 2003 o Windows Server 2008
(sistemas operativos de 64 bits son compatibles)

Todas las descargas de software Reform necesario pueden encontrarse en >> Seccién de

descargas. www.fabsoft.com

Requisitos de Hardware

Consulte la documentacion de Plugin Alchemy y MOST acerca de los requisitos de
Hardware.

Otros Requisitos

e Antes de iniciar este manual, MOST y Alchemy para Reform debe estar funcionando
correctamente.

Instalacion

Para instalar MOST-Alchemy a la instalacidn existente de Reform 12, necesita descargary
ejecutar el archivo ejecutable de instalacion MOST-Alchemy.

Siga paso a paso a través de los mensajes y acepte el acuerdo de licencia de usuario.
Para completar la instalacién.

El directorio de instalacion predeterminado para Reform 12 y sus plugins es C:\Program Files\
Reform...\. Si ha cambiado la ruta durante la rutina de instalacion Reform, o si utiliza un sistema
operativo de 64 bits, consulte la ruta adecuada en lugardel predeterminado al que hace referencia
a lo largo de esta documentacion.
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Después de la instalacion, debe reiniciar el MOST Manager (se puede ejecutar como un
servicio) ya que requiere que se carguen nuevos archivos al iniciarse. Para abrir el MOST
Manager, ir a Start>Programs>Reform...>MOST>Manager. Presione el botdn rojo de
detener y, a continuacién, el botén verde de inicio para hacerlo.

File Edt Tools ‘Window Help

L IE =
Log | Stats
= Connections Date Tirne Status ~
K5250300187 9/24/2009  44354PM  Login complete
L3BER300347 9/24/2009 4:43:54 PM Sending file to client: Logout. brmp
M anager 9/24,/2009 4:43:54 PM Sending file to client: Logout. bmp
9/24/2009 4:43:54 PM Sending file to client: Logout. bmp
9/24./2009 44354 PM Activating cached user data
9/24/2009 44354 PM Authentication successiul
9/24./2009 44354 PM Authenticating user: tutarial
9/24/2009 4:4353PM  Login started
9/24/2009 4:41:58PM Logouwt
9/24,/2009 4:40:24 P Login complete
[ - | 9/24/2009 4:40:24 P Send!ng f!le to client: Logout. brmp
Commachon Information 9/24,/2009 44024 P Sending file to client; Logout.bmp
9/24,/2009 4:40:23PM  Sending file to client: Logout.bmp
Serial  L3665900347 9/24,/2009 440:23PM  Sending user data
9/24/2003 44023 P Authentication successhul
IF: 132168.0.81 9/24/2009 44022 PM Authenticating uzer: tutorial
Alias:  [Mone] 9/24/2009 4:40:22 PM Login started
Logirc 9/24./2009 43946 P Authentication failed b
ogir - [Mone) P 5
Started

También debe reiniciar el servicio Reform Spooler. Se trata de permitir el Spooler para
reconocer los nuevos formularios instalados. Abrir el Spooler yendo a Start> Programs>
Reform...>Spooler. Haga click en el botdn Actualizar o el botdn rojo Detenery, a
continuacion, el botdn azul de Inicio

(@ Reform12 Spooler. Monitor - Unicode - Unregistered Version

File Action Log Help

o0 éf =

Forms Process Results

| Form MName Description Sec....

Start Service Account; Metwork Service
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Importando Pantallas MOST

Por favor, consulte el manual MOST para obtener mas informacién acerca de la
terminologia MOST, Configuracion MOST y prueba de conexidn.

Para importar las pantallas Most Ir a Start > Programs > Reform...> MOST-Alchemy >
Install MOST Screens

B Ricah_Refarm_PDC_v1z B MosT-alchermy B nstal
I Startup
- .. -

This will install Alchery screens in to the MOST designer|

Si no estd abierto aun, aparecerd MOST Designer. Se le pedird si desea importar Alchemy
en MOST. Haga click en Yes. Si se le solicita si desea sobrescribir archivos, haga click en Yes.

\?/ Impart Alchemy  inka MOST?

Puede dejar el MOST Designer ya que se utilizard en la siguiente seccion.

Servicio MOST Manager
Si ejecuta el MOST Manager como un servicio, la cuenta de inicio de sesién del servicio
debe tener los permisos adecuados para acceder al servidor de Alchemy. Para chequear

como que cuenta se esta ejecutando el servicio, ir a Control Panel>Administrative Tools>
Services.

File  Action “iew Help

Y EEEEI EIDEEEE

. Services (Local)

q Services (Local)

MOST 2.4 Manager Mame =« | Descripkion Status | Startup Type | Log On As | :I
& hMicrosoft Fibre Channel Platform R... Registerst... Manual Local Service

Stap the service “EhMicrosoft iSCSI Initiator Service Manages I... Manual Local System

Restart the service 4 Microsn =

Description: o

FabSoft's MOST Manager “EhMet. Tep Port Sharing Service Disabled Local Service LI

%, Extended 4 Stardard Vi

Servicio de Red/Sistema Local puede que no tenga suficientes permisos dependiendo de
su entorno. Para cambiar la cuenta de servicio de inicio de sesién, haga click derecho en
MOST 2.4 Manager y vaya a Properties. Seleccione la pestafia Log On.
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MOST 2.4 Manager Properties {Local Computer)
Gereral LogOn | Hecoveryl Dependenciesl

Log on as:

" Local System account

= illow service ko interact with desktop

% This account: I Browse. .. |

Pagswond: I

Confirm password: |

Help me confiqure user account log on optiors.

I ak. I Cancel | Apply |

Aqui puede introducir la cuenta y la contrasefia de una cuenta que tenga acceso al
servidor de Alchemy. Se recomienda utilizar una cuenta de dominio con privilegios
administrativos en el servidor de MOST y el servidor de Alchemy. Una vez finalizado,
haga click en el botén OK. Sera necesario reiniciar el servicio para que los cambios
surtan efecto. Esto se puede lograr al hacer click derecho en el servicio y seleccionando
Restart o simplemente por detener e iniciar el servicio.

Configurando las Global Variables

Necesitamos configurar la comunicacion entre MOST y Alchemy. Para ello, tenemos
gue configurar ciertos parametros en la pantalla de las Variables Globales MOST. Si el
MOST Designer no esta abierto aun, ir a Start>Programs> Reform... >SMOST>Designer.

En el menu de MOST Designer, ir a Data>Global Variables

& MOST Designer Q@E|
File  Edit View m Tools  Window  Help
- | == | | Users and Groups. .
Collections. ..
» Advanced Search ‘ Global Yariables. .
Static Data. . i EU"?;:;S
b et et Display Properties... Email
¥ Log Out Proximity Card Data... Save TaFile
P Preview H
} Process

Estas son las Variables Globales necesarias para acceder a su servidor de Alchemy. Para
obtener mas informacién acerca de las variables globales, consulte la documentacidn de
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Reform Alchemy. Seleccione una por una cada variable, introduzca su valor en el cuadro
proporcionado y, a continuacion, haga click en el botén Actualizar.

N

Nombre de Variable =AlchemyCacheExpire Valor= 20

Nombre de Variable =AlchemyDomain Valor =<Your Domain>
Nombre de Variable =Alchemy Server Valor=
http://SERVERNAME/AuWebService/AuWebService.asmx
Nombre de Variable = AlchemyTimeout Valor= 20

Global Yariables

Encrypt | Wariable | Walue |
O AlchemyCacheE =pire 20

O AlchernyD omain CompanyD omain

O AlchemyS erver http://SERVERHAME M ebSemvicedduiw'eb...
| AlchemyT imeout 20

Haga click en File>Save o utilice el icono pequefio de guardar = para guardar todas las
variables globales.

Asignando la coleccidon Alchemy a Usuarios

1.

Abra el MOST Designer si no esta abierta aun (Start>Programs> Reform...
>MOST>Designer).

En la barra de herramientas de MOST Designer, haga click en Data > Users and
Groups

8 MOST Designer,

File  Edit \Miew | Data | Tools  Window  Help
i s = NN Users and Groups...
- Buttan Objects Collections...
b Advanced Search Glabal variables. ..
Static Data...
D Ea B Display Properties... Value
» Log Out Proximity Card Data. .. e ame
3. Seleccione el usuario al que desea asignar la coleccién Alchemy. El usuario que

estd asignando la coleccidon Alchemy debe poder autenticarse en el servidor de
Alchemy. Para agregar un nuevo usuario, utilice el boton Add. Para el tutorial,
utilizaremos el usuario demo.

form12 Alchemy For MOST
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— Users/Groups [ Settings

= Users Loain Timeaut: m Scan Mode: lm
iy B o [Monochome =] Sides [Onwsaea 7]
. Domain Users Compression: | MH 2 File Type: lﬁ
Density: Im Scan Type: lm

Resolution; IEDD dpi = Sizer |Auto 'I

i~ Callections

Awailable Collections: Selected Collections:

Alchemny Save ToFile
Email
Adrmin

|-

Add Femave - hd

4. Seleccione Alchemy de las colecciones disponibles y haga click en él para

agregar a la coleccion de Alchemy del usuario seleccionado.

5. File>Save o utilice el icono pequefio de guardar = para guardar sus cambios.

Tutorial MOST Alchemy

El emulador muestra exactamente lo que se ve en un MFP y funciona de la misma
manera. Este mismo proceso podria probarse con los mismos pasos exactos, pero al
instalar MOST en el MFP siguiendo las instrucciones de los manuales MOST. (Consulte el
manual MOST acerca de cémo configurar MOST en un MFP.)

1. Conéctese a MOST en un MFP o use MOST Desktop (Start > Program >
Reform...>MOST>Misc>MOST Desktop).

Nombre de Usuario: demo (gl nombre de usuario gue se acaba de agregar)
Contrasefia: demo (La contrasefia del usuario agregado)

form12 Alchemy For MOST
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File

FARSOET
"" ] ||l.|:.|'r' uﬂm jm”“u"u 'Igﬂij"rﬂl !ﬂ.

www.fabsoft.com

lzername: | demo

Passwords || **** ‘ Log In ‘

Remember Me

B2009 FabSoft w22, 00825, 622

2. Elemulador ahora se conectara al servidor MOST e inicie la sesién. Puede tardar
varios segundos para iniciar la sesién, ya que MOST debe conectarse al servidor
de Alchemy para recuperar la configuracidn de la cuenta.

I MosT P [
File

Informacion del documento:

Base de Datos/Carpeta
| d

Informacién del documento:

“

aCerrarSesion Escanear

3. Utilice el menu desplegable de Base de datos/Carpeta para ver una lista de carpetas
disponibles. Haga click en cualquier lugar en el cuadro combinado para abrir esta lista.

Alchemy For MOST
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=00 %]

I MOsT
File

Informacion del documento:

Base de Datos/Carpeta

Carpeta 1/ Prueba 1
Carpeta 2/ Prueba 2
Carpeta 3/ Prueba 3
Carpeta 4/ Prueba 4/Prueba 4-1
Carpeta 5/ Prueba 5/Prueba 5-1
Carpeta 6/ Prueba 6/Prueba 6-1

aCerrarSeswon Escanear

4. Después de seleccionar un destino Base de datos/Carpeta, el cuadro de lista se
rellenara con las propiedades del documento. Estas son las propiedades
establecidas sobre la base de datos de Alchemy. Para escribir informacion de los
campos, simplemente haga click en el area sombreada junto al nombre del

campo.

I [=1 3

= MOST
File

Informacion del

Baze de Datos/Carpeta
| Carpeta 1/Prueba 1 R4

documento:

&1 chemy

Informacién del documento:
Titulo del documento —
Mamero de documento I

Propietario del documento

Tipo de documento

Presione'haga click para rellenar el campo

aCerrarSesion Escaneal"

5. El procedimiento anterior puede repetirse para cada campo deseado.

Reform12 Alchemy For MOST
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ZIMosT = e
File

Informacion del documento:
Baze de Datos/Carpeta
e |Carpeta 1/Prueba 1 | v|
Informacién del documento:
Titulo del documento Documento de Prueba 1 j
MNumero de documento 123456789
Propietario del documento MNombre de Usuario
Tipo de documento Pedido de Venta
aCerrarSesion Escanear

6. Cuando haya terminado de rellenar las propiedades del documento, haga clic en
el botdén verde de Escanear para enviar el documento al servidor de Alchemy.

ZIMOST =101 x]
File

Informacidn del documento:

Baze de latos/Tarpeta
|Carpeta 1/Prueba 1 R4

Irtormacién del documento:

Titulo del documento Documento de Prueba 1
Numero de documento 123456789
Propietario del documento Nombre de Usuario
Tipo de documento Pedido de Venta
aCerrarSesiUn Escanear

7. Se ha completado el tutorial de Alchemy. Puede comprobar que el documento
ha cargado correctamente en el servidor de Alchemy. Si no ve el documento,
por favor, aseglrese de que es capaz de cargar documentos utilizando el plugin
de Reform 12 Alchemy haciendo referencia a la documentacidon de Reform
Alchemy.

Mantenimiento
Hay ciertos directorios que deben controlarse para crecimiento, junto con el plugin for
Reform 12. Cada vez que un sistema procesa mds y mas trabajos, el tamafio de estos

>form 12 Alchemy For MOST
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directorios puede crecer muy rapidamente. En general el rendimiento del sistema
puede verse afectado por la gran cantidad de espacio que pueden ocupar los archivos.
Entradas obsoletas archivos/base de datos se deben eliminar de acuerdo a sus
necesidades y especificaciones de retencion de archivos. Se recomienda monitorear el
crecimiento de los siguientes directorios:

Directorios:
C:\Program Files\Reform...\Backups
C:\Program Files\Reform...\Spooler\ImageQueue

Solucion de Problemas

1. Si tiene problemas para conectarse al servidor de Alchemy usando Reform o MOST, es
importante que el servidor permite conexiones de las cuentas de equipo y servicio de
Reform Spooler y MOST Manager. La cuenta de servicio MOST Manager es responsable
de directorios de Alchemy en la pantalla de MOST. La cuenta de servicio Reform
Spooler es responsable de cargar el documento cuando se hace click en el botén
Escanear. Estos dos servicios deben tener acceso al servidor de Alchemy.

Abrir una pagina de Internet Explorer. Escriba http://ALCHEMYSERVERNAME
/AuWebService/AuWebService.asmx en |la barra de direcciones.

Asegurese de que se tiene acceso a esta pagina. Si se le solicita iniciar sesién, inicie la
sesién con las credenciales correctas.

Cuando se conecta correctamente, vera lo siguiente:

G-

File Edt View Favorites Tools Help

=4 [ % | Juve searcn

v (& muwebService Web Service ' - B - - |5 Page » (G Took

AuWebService

The following operations are supported. For a formal definition, please review the Service Description.

* EngineStatus
« IdentifyCaller

« ProcessRequest

This web service is using http://tempuri.org/ as its default namespace.

Recommendation: Change the default namespace before the XML Web service is made public.

er for client applications to distinguish it from other
< unde:

eeds a unique name: it
ailable for XML Web der development, but published XML Web se

Your XML Web service should be identified by @ namespace that you control. For example, you can use your company's Internet domain name
part of the namespace. Although many XML Web service namespaces look like URLs, they nead not point to actual resources on the Web. (XML
Web service namespaces are URIS.)

For XML Web services creating using ASP.NET, the default namespace can be changed using the WebService attribute's Namespace property. T
WebService attribute is an attribute applied to the class that contains the XML Web service methods. Below is a code example that sets the
o "http: y "

c#

[WebService (Namespace="http://microsoft.com/webservices/") ]
public class MyWebService {

// implementation
¥

visual Basic
<WebSexrvice (Namespace:="http://microsoft.com/webservices/")> Public Class MyWebService

' implementation
End Class
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Intente ejecutar el tutorial MOST Alchemy nuevamente después de conectar
correctamente.

2. También es importante tener en cuenta que el usuario en MOST que tiene acceso a la
coleccién Alchemy también debe poder autenticarse en el servidor de Alchemy.

3. Si se ejecuta MOST como un servicio, consulte Servicio MOST Manager Service

Otros nombres de empresas o productos mencionados en este documento pueden ser
marcas comerciales o marcas registradas de sus respectivas empresas

form12 Alchemy For MOST
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